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QUESTION 1
SIMULATION
Project 5 of 7: City Sports

Overview

The city events manager wants to analyze the enroliment changes over the past five years for various adult and youth
sports programs. You have been tasked to prepare tables for the analysis.
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| Adult Enrollment
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12 [Bowling : i ! S i 2 123
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14 |Flag Football : L SEL i 2 = ki
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CitySports - Excel = = | x

Insert Page Layout Farmulas Data Review e @ Tell me what you want to do Sign in 2_ Share
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< Youth Enrollment
9: Sport Yearl Year 2 Year3 Yeard Year s Total
10 DK Run 14 25 24 a7 89 209
11| Basketball 100 120 120 130 150 620
12 Bowling 12 24 24 36 36 132
13| Cycling 3 10 15 15 2209 2254
14| Flag Football 120 160 130 200 240 500
15 Lacrosse 40 B30 100 120 140 4380
16 | Soccer 200 220 220 240 300 1180
17 Softball 200 200 200 200 200 1000
18 Swimming 40 50 50 60 60 260 ||
19 Tennis 45 30 50 70 80 275
20
21|
22 =

| Adult Program Youth Program (&5 [ e ————————— [v]

Ready =l s + + 100%

On the “Youth Program” worksheet, create a table from the cell range A9:G19. Include row 9 as headers.
Correct Answer: See explanation below.

Explanation:

1.

On the “Youth Program” worksheet, select Format as Table from the Home tab.
2.

Choose the desired style for the table.

3.

Select the desired cell range of A9:G19 in the Format as Table dialog box.

4.

Mark row 9 as a header.

5.
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Click OK.
References:

https://support.office.com/en-us/article/create-and-format-tables-e81aa349-b006-4f8a-9806-5af9df0ac664

QUESTION 2

SIMULATION

Project 4 of 7: Car Inventory
Overview

You manage the office of a used car business. You have been asked to prepare the inventory list for a big annual sale.
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> Carlnventory - Excel = (m| x
Insert Page Layout Formulas Data Review View me wha ia... Sign in P_‘,_ Share
LT 4 Calibri =__ - %-(J General - Ccmdi‘ticmal Formatting + E"Insert v Z - ;'l'v
p D Eg - = e $-% > EFurrnnL as Table - E" Delete - E =i
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Clipboard = Font P Alignment . Mumber m Styles Cells Editing ~
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9 |Make Model Body Year Color Mileage Price Inspected Discounted Price |
10 |Mitsubishi 3000 GT Sport 1985 White 198000 54.000.00 Yes
11 |Honda Civic 4-door 2000 Red 150000 53,000.00 No
12 |Ford Ranger Pickup 1986 Blue 208000 53.200.00 Yes
13 |Dodge Intrepid Coupe 2002 | Silver 148,000 53,000.00 Yes
14 |Cadillac Seville 4-door 2002 White 141,000 54100.00 Yes |
15 |Ford Ranger Pickup 1995 Black 135,000 54700.00 Yes
16 Ford Mustang ESport 1999 Red 188,000 55500.00 Yes :
17 |Chevrolet Camaro Sport 2004 White 122,000 57,000.00 |Yes :
18 |Chevrolet Silverado Truck 2001 Black 178,000 $5,200.00 Yes |
19 |Toyota Tacoma Pickup 2006 White ‘08,000 59,300.00 No
20 |Ford Taurus Sedan 2008 Gold 102,000 59.800.00 No
21 |Mazda Miata Sport 2010 Blue 77,000 58500.00 No
22 |Mercedes 5005L Converible 2003 Gold 185,000 58.000.00 No |
23 |leep Wrangler Converible 2005 Black 122 000 58,200.00 No |
24 |Chevrolet Impala Sedan 2000 Maroon 162,000 54100.00 Yes
25 |Mitsubishi Diamante 4-door 2008 Gold 92,000 HHEE Yes :
26 |Ford Focus Coupe 2012 Blue 58,000 57.900.00 Yes |
27 |Mazda RX-7 Spart 1885 Silver 210,000 53.100.00 Yes
28 |Harley Davidson  Sportster Motorcycle 2009 Black B2 000 5750000 No '
29 |Honda Gold Wing Motorgicle 2010 Red 76,000 510,100.00 No |
30 |Toyota Tacoma Pickup 2008 Black 78,000 RS No .
31 |Ford Ranger Pickup 19495 Black 135,000 54700.00 No |
32 |Ford Mustang Sport 2000 White 171,000 57.500.00 No ,
33 |Chevrolet Camaro Sport 2005 White 115,000 $8,000.00 No
34 |leep Wrangler Convertible 2006 White 112 000 HiEagaad Yes '
35 |Chevrolet Impala Sedan 2007 Maroon 112,000 5610000 Yes ;
36 |Mitsubishi Diamante 4-door 2009 Blue 63,000 HahkER Yes '
37 |Honda Civic 4-daoor 2000 Blue 145,000 53,200.00 Yes |
38 |Ford Ranger Pickup 1985 White 188,000 53.700.00 Yes
39: Dodege Intrepid Coupe 2005 Silver 137,000 53B00.00 Yes
40 |Chevrolet Silverado Truck 2004 White 158,000 57,200.00 Yes
41| -
Car Inventory | (&) .- bl
Ready i - I + B5%

Configure the “Car Inventory” worksheet so the column headings in row 9 appear on all printed pages.

Correct Answer: See explanation below.

Explanation:

1.

On the “Car Inventory” worksheet, click Print Titles from the Page Setup group, situated on the PageLayout tab.

2.
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Under Print Titles, on the Sheet tab, type the reference of the row you want to reappear (row 9) in the Rows to repeat at
top box.

References:

https://support.office.com/en-us/article/Print-rows-with-column-headers-on-top-of-every-page-
D3550133F6A1-4C72-AD70-5309A2E8FE8SC

QUESTION 3
SIMULATION

Project 6 of 7: Bike Tours Overview

You are the owner of a small bicycle tour company summarizing trail rides that have been booked for the next six
months.

¥ BikeTours - Excel Table Tools = = O X
Insert Page Layout Formulas Data Review View Design Q Tell me.. Sign in H_ Share
"D \ia Calibri P == N - % General v %Condi‘tional Farmatting ~ Insert - E A ;? v
Eg ~ || o $ - % »  [¥FormatasTable~ 2 Delete = - P~
F‘E"JtE o ;L u- R L- =E==== & 6 8 L-'FCEII Styles - EI Format~ & -
Clipboard & Font =1 Alignment (1 Number Tu Styles Cells Editing -~
A6 > fx Bike Tour v
_ A B . c | D | E | F , G H | [+]
1 —
2 - - L) i = =]
. Adventure Works
4
5 —
5 - | v A4 - v - - | v_ | -
7 |Casual Biker Inn Tour  July Toby Nixan 4-Day/3-N 11 $600.00 $6,600.00 |
8 |Casual BikerInn Tour  August Sabina Schuetz 4-Day/3-N 2 $600.00 51,200.00
9 |Casual BikerInn Tour  September Mindy Martin 4-Day/3-N 4 5600.00 $2,400.00
10 |Gully Wash Loop July Lee Oliver 1/2 Day 5 $75.00 $375.00
11 |Gully Wash Loop August Katie Jordan 1/2 Day 10 $75.00  $750.00 |
12 |Gully Wash Loop September Kathie Flood 1/2 Day 16 $75.00 $1,200.00
13 |Kokopelli Trail July Julian Isla 4-Day/3-N 15 5450.00 56,750.00
14 |Kokopelli Trail August Judy Lew 4-Day/3-N 12 $450.00 $5,400.00
15 |Kokopelli Trail September John Peoples 4-Day/3-N 10 $450.00 $4,500.00 |
16 |Raccoon Rim Trail July Iris Rogers 1 Day 20 $110.00 %52,200.00
17 |Raccoon Rim Trail August Holly Dickson 1Day g $110.00  S$880.00
18 |Raccoon Rim Trail September Gail Erickson 1 Day 7 $110.00 $770.00
19 |Slickrock Trail July Eric Gruber 1/2 Day a0 $75.00 $3,000.00 |
20 |Slickrock Trail August Debra Core 1/2 Day 9 $75.00 5675.00
21 |Slickrock Trail September Chris Ashton 1/2 Day 21 $75.00 $1,575.00
22 |White Pine Trail July Bradley Beck 3-Day/2-N 15 $300.00 54,500.00
23 |White Pine Trail August Bonnie Kearney 3-Day/2-N ] 5300.00 51,800.00
24 |White Pine Trail September Arlene Huff 3-Day/2-N 12 $300.00 $3,600.00
_25___ -
Summer Bookings | (&) 1 ' [r
Ready HH m - ] +  100%

Insert page numbering in the center of the footer on the “Summer Bookings” worksheet using the format Page 1 of ?.
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Correct Answer: See explanation below.

Explanation:

1. On the “Summer Bookings” worksheet, click Header and Footer from the Text group situation on the

Insert tab.

2.

Click Click to add footer which would display the Header and Footer tools which gets added to the Design tab.

3.

Specify where the page number should be by selecting the Center section box.

4.

On the Design tab in the Header and Footer Elements group, click Page Number.

5.

The placeholder and[Page] will appear in the selected section, to add the total number of pages type the word of
followed by the space in the Header and Footer Elements group after clicking Number of Pages, then the placeholder
and[Page] of and[Pages] appear.

6.

Click anywhere outside the header or footer area to display the page numbers in Page Layout View.

7.

Once you are done working in the Page Layout View, click Normal in the Workbook Views group situated on the View
tab. OR You can also click Normal on the status bar.

References:

https://support.office.com/en-us/article/Insert-page-numbers-on-
worksheets-27A88FB9-F54E-4AC4-84D7BF957C6CE29C

QUESTION 4
SIMULATION
Project 6 of 7: Bike Tours Overview

You are the owner of a small bicycle tour company summarizing trail rides that have been booked for the next six
months.
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¥ BikeTours - Excel Table Tools = = ! x
Insert Page Layout Formulas i View Design Q@ Tell me.. Sign in R_ Share
&D J__‘ i o P | = o P = General i E'_‘E Conditional Formatting = Insert ~ | 2 ~ ’2"!' -
Eg ~ || o $ - % »  [¥FormatasTable~ 2 Delete = - P~
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Clipboard Font (] Alignment | Number P Styles Cells Editing ~
A6 > F || BikeTour v
. A B . c | D | E | F _ G H | [+]
1 —
2 z i e a
:l Adventure Works
4
5
‘ = - - 2 - - £ Brou &
7 |Casual BikerinnTour  July Toby Nixon 4-Day/3-N 11 $600.00 $6,600.00 |
8 |Casual BikerInn Tour  August Sabina Schuetz 4-Day/3-N 2 $600.00 51,200.00
9 |Casual Biker Inn Tour  September Mindy Martin 4-Day/3-N 4 $600.00 $2,400.00 |
10 |Gully Wash Loop July Lee Oliver 1/2 Day 5 $75.00 $375.00
11 |Gully Wash Loop August Katie Jordan 1/2 Day 10 $75.00  $750.00 |
12 |Gully Wash Loop September Kathie Flood 1/2 Day 16 $75.00 $1,200.00
13 |Kokopelli Trail July Julian Isla 4-Day/3-N 15 5450.00 56,750.00
14 |Kokopelli Trail August Judy Lew 4-Day/3-N 12 $450.00 55,400.00
15 |Kokopelli Trail September John Peoples 4-Day/3-N 10 $450.00 $4,500.00 |
16 |Raccoon Rim Trail July Iris Rogers 1Day 20 $110.00 $2,200.00
17 |Raccoon Rim Trail August Holly Dickson 1 Day 8 5110.00  $880.00 |
18 |Raccoon Rim Trail September Gail Erickson 1 Day T $110.00 $770.00
19 |Slickrock Trail July Eric Gruber 1/2 Day a0 $75.00 $3,000.00 |
20 |Slickrock Trail August Debra Core 1/2 Day ] $75.00  $675.00
21 |Slickrock Trail September Chris Ashton 1/2 Day 21 $75.00 $1,575.00 |
22 |White Pine Trail July Bradley Beck 3-Day/2-N 15 $300.00 54,500.00
23 |White Pine Trail August Bonnie Kearney 3-Day/2-N 6 $300.00 $1,800.00 |
24 |White Pine Trail September Arlene Huff 3-Day/2-N 12 $300.00 $3,600.00
_25__ -
Summer Bookings | (&) 1 ' [r
Ready B m - | + 100

On the “Summer Bookings” worksheet, remove the table functionality from the table. Retain the cell formatting and
location of the data.

Correct Answer: See explanation below.

Explanation:

1.

Click Design from the Ribbon on Table Tools.

2.

In the Tools group, click on Convert to Range.

OR

1. Right-click the table then click on Table then press Convert to Range.

References:

77-727 PDF Dumps | 77-727 VCE Dumps | 77-727 Study Guide 9/12


https://www.pass4itsure.com/77-727.html
https://www.pass4itsure.com/77-727.html
https://www.pass4itsure.com/77-727.html

. VCE & PDF https://www.pass4itsure.com/77-727.html
a 2024 Latest passditsure 77-727 PDF and VCE dumps Download

— PassditSure.com

https://support.office.com/en-us/article/convert-an-excel-table-to-a-range-of-data-0b326ff1-1764-4ebe84ea-786265d41c
77?redirectSourcePath=%252fen-us%252farticle%252fRemove-a-table-without-losingthe-data-or-table-format-
ADF88635-90F5-4FAA-9417-19862F38CCE8andui=en-USandrs=en-USandad=US

QUESTION 5

SIMULATION

Project 7 of 7: Farmers Market
Overview

You are the Director of a local farmers’ market. You are creating and modifying charts for a report which shows the
amounts and variety of products sold during the season.
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. Farmers Market
5 | A
6| .| | | ! | |
7| Products | | March || April |~ | May |~ | Total B3|
8 Lt $3,900.00  $7,200.00  $9,538.00  $20,638.00
9 | Vegetables $1,520.00 $6,438.00 $4,533.00 $12,491.00 |
10 Jams & Honey $502000  $673800  $8323.00  $20,091.00,
1|
12 |
1) Chart Title
141 !
15|
1) !
17_
183 !
197 l :
20 i / B
2t M | Izl wli - |
22— Fruits Vegetables Jam= & Honey = =
— March mAprl =May mTotal : ~Friits =% e e S B
= - v Fruits - Vegetables Janw&i{oma_f_. o __.5

Spring Sales | Summer Sales | ® [« T[]
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FarmersMarket - Encel

Page Layout Formulas Data Review View @ Tell me what yo .. Sign in ,‘;_"_5
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aste B I U-~- i [T === == E, $ At S ] onditional Format as &l et it in
2 ¥ < e Formatting~ Table~ Styles~ EiFormats | & v Erecs Select -
Clipboard Font (F1 Alignment 71 Number F] Styles Cells Editing -
A6 = f ¥
4| | e | D E | | | -} | K L [~
1_
2_
: k
o Farmers Market
5 |
z
7| Products |~ |June |~ |July | ~ | August |~ |Total |=
8 | Baked $1,566.00 $1,709.00 $1,854.00 $5,129.00
2 | Dairy $2,532.00 $3,209.00 $4,356.00 $10,097.00
10| Meat & Eggs $6,670.00 $7,580.00 48,864.00 423,114.00
11 Fruits $4,577.00 $8,908.00 410,858.00 $24,343.00
12 Vegetables $3,300.00 $8,321.00 $11,876.00 $23,497.00
13| Jams & Honey $8,254.00 $7,396.00 $9,508.00 $25,158.00
Top Sellers
S12. 00000
S1o0ca00
£8,000.00
£6 00000
££.500.00
53.000.00

Jams & Honey

| spring Sales Summer Sales (O] [«T ] []

Ready @ mo- I ~+  100%
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On the “Spring Sales” worksheet, apply Style 3 and Monochromatic Color 2 (Monochromatic Palette 2) to the 3-D Pie
chart.

Correct Answer: See explanation below.

Explanation:

1.

Click on the 3-D Pie Chart on the “Spring Sales” worksheet.
2.

This would display the Chart Tools, click on the desired style which is Style 3 Monochromatic Color 2 from the Chart
Styles group situated on the Design tab.

References:

https://support.office.com/en-us/article/Change-the-layout-or-style-of-a-chart-
A346E438-D22A-4540-AA87BCE9FEB719CF
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